Acrobat Pro

By Don Bremer
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OCR

One word — Quality!

The difference between having a document that you will be able to edit using OCR and one that you will
only be able to search (still incredibly useful) is the quality of the scan. If the scan looks like a book page,
we can make changes. If it looks like a picture — it may only be good for search.

Open the file: OCR-good-quality.png

This is a scanned page | got from Google. Opening this up in your favorite picture editor, you can now
save this as a PDF. Then, open this PDF in Adobe.

This is a picture — since when we try to select anything, it selects the whole image. Let’s
run this through OCR.

Scan & OCR

A new toolbar appears. [Add [+]

I:%, Insert = @,\ Enhance ~  AA Recognize Text ~ @ Bates Numbering ~ [?1 D a

Enhance Scanned PDF

Enhance should be used when the file may not have worked well in the beginning. So, o

see if the file works —and if not, use enhance! ®curentage
FomPage [T Tofi

Optimization Options

In the settings, there are 3 different ways to change the file. R e o
Color/Grayscale: |JPEG2000 ~
e Searchable Image onodvome [ETEES)
Small Size High Quality
e Searchable Image (exact) Fiers
[ ] Enable Text and |m a ges S:::::gnhij;kgmuna Removal (Off), Descreen (On), Text

Edit

The searchable image (exact) will still show the document as an image — but it will then ~ Tefesmonoren

Recognize Text

be editable. So, click on the “Recognize Text” button. e SO G

Edit

You can now select text and copy it to another document. T iz

vy wuy us

k en espafiol band’s music provided the soundtrack for Coors Light
ercials during Monday Night Football broadcasts, and still others as
| music for Levi’s jeans commercials aired during the Super Bowl and
egularly on television. In 2001, The Tonight Show host Jay Leno hosted
ypelados,” a rock band from Colombia that became wildly popular
the world in the 1990s and continues to produce some of the most
rded rock en espafiol and Latin alternative music in the 2000s. By the
12000s, Colombian pop-rock star Shakira could be seen in as many
nercials as MTV music videos, and was being touted by the music
‘the next Madonna’ Most recently, the Colombian pop-rock star Juanes
ed artist at the 2009 NBA All-Star game. As a result of these and other
fts such as 2000 US Census data revealing the emergence of Latinos/
as the largest minority group in the US, contemporary Latino/as are
new areas increasingly worthy of scholarly investigation.

ioting is the fact that although the latest US Census revealed that
re now the largest minority group, the news came on the heels of a
ontroversy for Latino/as. From legacies of racism and ethnocentrism

[colombian pop-rock star Shakka

Or, try to search for the word: Madonna.

It’s not perfect — but we may get lucky. For perfection — go for Pets!
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You can now actuallyhave the document read out loud for you. Under View->Read Out Loud.
If you know you want to edit the PDF after you create the OCR, just click on the Edit PDF. When I click

on the Edit PDF — it runs an OCR scan again. So, if you are using large documents — skip the OCR first.

Bates Numbering

This is a way of putting unique numbers on legal, medical, or business documents.
Open the document: Working With Data.pdf

Now, go to the Scan/OCR tab and on top select Bates Numbering and select Add....

Add...

Remove...

If this is a legal case, you might have hundreds of documents. So, the next screen will allow one to add
many documents to do this at once.

Bates Numbering - m] X
[B Add Files..

Add the files to be Bates numbered.
Arrange them in the order in which you want the Bates numbers to appear.

Name Size Created Modified ‘Warnings/Errors
- Working with Data.pdf 1.13 MB 2021-06-18... 2020-06-23...

Move Up ove Do Remove

Help Output Options oK Cancel

For us, we only have one, so click ok.
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Then, we have how we want to add the numbers

Center Header Text Right Header Text
Saved Settings: |[None specified] - elet ave Seltiogs ‘ ‘
Font Margin (inches) Center Footer Text Right Footer Text
Name: | Aila]  Sze 8 U m op 052 Botom o5 |5
Lok 1 2 g [r ‘ ‘
Left Header Text Center Header Text Right Header Text
‘ ‘ ‘ Insert Date Page Number and Da
Left Footer lext Center Faoter lext Right Faoter Text Page Number and Date Format ><
Insert Bates Number. Insert Date ‘aqe Number and Date Forma 1e Range C
Preview ______u Date Format:  KApAAANMReL >
= Bates Numbering Options X
Preview Page |1 - ofs Fage Fange Options...
Number of Digits: |8 2 Page Number Format:  Bates Number .

B

Prefx 3 Start Page Number: |1 :
T e R Cancel

i

fmmpmm————

This will place a unique number on each of the documents.

Save As Other
A question came up — “What is with all the different types of PDFs Reduced Size PDF...
to save to?”. For those who may never have looked, if you click on Certified PDF...

File->Save As Other, you can get a few different types of PDFs.
Reader Extended PDF

Reduced Size PDF — The Reduce File Size command resamples and
recompresses images, removes embedded Base-14 fonts, and
subset-embeds fonts that were left embedded. It also compresses T S

) ) Archivable PDF (PD
document structure and cleans up elements such as invalid
bookmarks. If the file size is already as small as possible, this
command has no effect.

Optimized PDF...

PDF (PD

Note: This will remove the digital signature if there is one.

Certified PDF — If you are the author of a PDF file, and want to maintain its integrity, apply a certifying
signature with the Certify tool. When you certify - rather than add a digital signature - you can control
use of the document with the following permitted actions:

e Disallow any changes: Disables all tools that can be used to change a file, such as editing,
commenting, form filling and signing. If any change is made to the document after certification,
its certificate becomes invalid.

e Only allow form fill-in actions: Disables all tools that can be used to change a file, except for the
form filling and signing tools. An example of when you would use this is when you want to
collect information with an official form that requires people to enter information, but does not
allow them to change the form you designed.

e  Only allow commenting and form fill-in actions: Disables all tools that can be used to change a
file, except for the form filling, signing, and commenting tools. An example of when you would
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use this is when reviewing a contract that may require signatures and comments during the
reviewing stage.

Optimized PDF — This will change the quality of the final output and will be covered in a later section.

Archivable PDF - PDF/A differs from PDF by prohibiting features unsuitable for long-term archiving, such
as font linking (as opposed to font embedding) and encryption.

Press Ready PDF - Press ready PDFs are usually the preferred format for commercial lithographic
printers when supplying artwork. Press ready PDFs differ from standard PDFs in that they must meet a
certain criteria in order for the file to print without problems. Standard PDFs may include colours that
may not print correctly or graphics that are fine to view on screen but will print at a very low quality.
Each printer will have their own specifications for supplying artwork

PDF/E- This standard defines a format (PDF/E) for the creation of documents used in geospatial,
construction and manufacturing workflows|[

What is the difference between a signed document and a certified document? » During the signature of
a document, the integrity of the documents data's is guaranteed by your digital signature. ... During the
certification of a document, you are still using a digital signature to guarantee the integrity of the
document.

Prepare Forms

Word Forms are great! But, not everyone has Word. But — everyone has Adobe Reader! Let’s make a
PDF form from a Word Document.

Forms & Signatures

FEATURED

74 =) &%

Request Signatures Fill & Sign Prepare Form Certificates

‘.Open '.‘ ‘Open '| |Add '.‘ ‘.Add '|

Let’s use the File Employment Application. We don’t need document signatures in this case, but we
want to keep the form field auto detection ON.
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Preferences X

Categories: General
Commenting “ Automatically calculate field values
Documents
Full Sereen Automatically adjust tab order when modifying fields Manage Barcode Parameters...
General Show focus rectangle
Page Displa
9 Py Show text field overflow indicator
Accessibility Show field preview when creating or editing form fields
Action Wizard n cally d z field
Adobe Online Services utomatically detect Form fields
Catalog Auto-enable text editing in Prepare Form

Color Management
Content Editing
Convert From PDF

Convert To PDF Show border hover color for fields
Email Accounts

Fields highlight color: O

Highlight Color

Identity
Internet Required fields highlight color: |l
JavaScript
Language
g g Auto-Complete
Measuring (2D)
Measuring (3D) Off v Remember numerical data (e.g., telephone number)

Measuring (Geo)
Multimedia & 3D
Multimedia (legacy) Edit Entry List...

Multimedia Trust (legacy)

The auto-complete feature is now off. No suggestions will be made while you type in form fields. Choose Basic or Advanced from the drop-down
box to turn the feature on.

Reading

Reviewing

Search

Security

Security (Enhanced)
Signatures

Spelling

Tracker .| [orm Tracker Preferences

All of the easy location have been tagged by Adobe, but the information at the top has not been tagged
as a form. Adobe gives us lots of tools to complete the form.

e Add a text box for applying to position Toxt Field Prop

General Appearance Position Options Actions Format Validate Calculate

YOUR LOGO Name: |PositionApp|iedFor
HERE
Tooltip: |
Applying for Position: § Text1 } Preferred P
Can drive to work: Languages

Can bring donuts to wo
Start Date:

Field Name:

Employment Appl required field Al Properties

Full Name:

Common Properties
Form Field: | Visible & ] Read Only
¥ degrees [ Required

Orientation: |0

[ tocked Close
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e Add a checkbox to can drive to work.
e Add a Radio Button to Can Bring Donuts to Work (add fields Yes/No/Maybe)

o | reenea
Q@ Languages Ki
S

Radio Button Choice: @

Applica
‘Choice1 ‘ I
Group Name: Dropdown Properties
‘ Group3 v ‘ ‘-
[ Required field All Properties General Appearance Position Options Actions Format Validate Calculate
— 1, Warning: 1 button in group. At least 2 _—
Address
adaress | buttons needed. L ftem: ‘pHp Add

Export Value: ‘PHP
Add Another Button

ItemList: | C

Delete
C++
e Add a date field for Start Date e Up
e Add a Dropdown list to Preferred Programming .
Languages (C,C++,Java,PHP)
e Add a List Box With all those languages. Make sure to
[Jsortitems

click on Multiple selection.
e Add a button to reset the form on the top

[] Allow user to enter custom text
Check spelling

[] Commiit selected value immediately

=

. | Button Properties n
NOW that we have ‘t n Q Select an item in the list to make it the default ~

1 e an Action , rhnica v
the basics, we can § S "
look at the A s :
. . bl st 5 Cormpaible] Locked
information on the | Por b ot ol i L locs Tz
right side of the form o
tools. [ | |

[Miocked o

To select the items, draw a bounding box around the items — ctrl click does not work. Select the radio
buttons and set to the same size and align top.

Align, Distribute or Center

Set Fields to Same Size
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The fields on the right side may be an easier way to make sure you are
grabbing the right form element and properties. You can also:

e Align

e Rename

e Match Size
e Center

e Distribute

The Filled form

We have the form and the data, so what do we do with it?

We can open the form with the data in Acrobat. Then, we can export this
form data to a form data file (fdf). Go to More then select export data.

This does not save the entire form — just the data.

But, what happens when we get all these forms coming back to us? We
normally don’t want to print out each one. What we would like to do is to
put them in a spreadsheet and look at the data that way.

On the tools section, select Merge Data Files into Spreadsheets...

Select all the files under Filled Forms.

Export Data From Multiple Forms X

Please add files that you wish to export data from

Add Files Files to Export Data From

CarlSagan.pdf

Remove Files BenFranklin.pdf

Abelincoln.pdf

Include most recent list of files to export data from

Q Data files you add should be from the same form. Data files do not need to
be added in any specific order.

Export Cancel

And then select Export. This will send the file to a CSV.

MATCH SIZE

Preview

CENTER

=
23]

DISTRIBUTE

Tr More

FIELDS

If yes when
YES 4
NO_4

If yes explain
High School
Address_2
From

To

YES(S

NO_5
Diploma
College
Address_3
From_2
ifo)

YES 6
NO_6
Degree
Other
From_3
To_3

YESHT,
NO_7
Degree 2
PositionAppliedFor
Check Box2
Group3
StartDate

PerferredProgramming

AllLanguages|
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AutoSave (@ off)

F Click to turn on AutoSave for this file Layout Formulas Da
ij" cut Calibri Vi1 v AT A
R Copy ~
= . B I U-. v Ov AL
v é/“ Format Painter —
Clipboard [} Font [
Al - ke
A B . C . D . E K
. _|Fu|| Name Date Address City Phone
|AbelincoliAbe Lincoln
BenFrankl Franklin Ben

| Carlsagan Sagan Carl

[V I R VYV S I

Distribution and Tracking

All this form integration is great — but now we have to get it to
people! That’s where the Distribute and Track Buttons appear!

Click on the Distribute button.

We first have to figure out how we are going to distribute the files.
Is it through an Email or an Internal Server. You will probably need

Track...

your IT department to set it up on an Internaal server —so | will use the email option!

Distribute Form

How would you like to distribute the form?

® E Email
Distribute, collect data using Email and Adobe Acrobat
O E‘ Internal Server

Distribute, collect data using SharePoint or Network Folder

Cancel

X

Distribute.
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We will send the document through Acrobat.

Distribute Form X Distribute Form X
How do you want to distribute your form? Delivery Method:  Manually collect responses in my email inbox

(® Send using Adobe Acrobat o dbremer@donneray.com;

DonBremer@gmail.com

(O save a local copy and manually send it later

Subject: Please complete the form Abelincoln_distributed.pdf

Message: C\Users\Don\Desktop\June 18202 1\FilledForms\Abelin...  Reset default message

You are invited to complete the form "Abelincoln_distributed.pdf". You can use Adobe Acrobat or
\Adobe Acrobat Reader to fill in this form.

Click the attachment to open the form in Adobe Acrobat or Adobe Acrobat Reader. When you are
finished, click Submit to return your data to the form author.

Get the free latest version of Adobe Acrobat Reader from:
<http://www.adobe.com/go/reader>

(; Using the ‘Send using Adobe Acrobat' option, one can choose to send the
email using installed email client or configure web based mail accounts.

Collect name & email from recipients to provide optimal tracking

This will launch the tracker section. It shows how many have been distributed and how many people
have responded to the form.

@ Tracker _ O %
[ Latest Updates Forms > Distributed > AbeLincoln_responses
v &4 Reviews
7~ View Responses
[5 Sent
[ Joined
s & Forms

v f'%g Distributed Response File Location: C:\Users\Don\Desktop\June182021\FilledForms\Abelincoln_responses.pdf (Edit file location

Your form has been successfully distributed. Responses will be combined into a single file.

@ Abelincoln_responses Distributed On: 2021-06-21 12:14:51 PM using email attachment

=] Received
- ‘aj Open Original Form

&J Responses

Recipients Responded (New): 0
Recipients Not Responded: 2
Total Recipients: 2

* 1
(‘% Email All Recipients Qﬂ"i Add Recipients @5 Email Recipients Who Haven't Responded

Email Recipient Name Responded Last Response Date/Time
dbremer@donneray.com No
donbremer@gmail.com No

Bpand All Collapse Al @ T <
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The email that comes in says “can use” Acrobat or Acrobat Reader. It really should say “should use”
Acrobat or Acrobat Reader. Some lightweight readers may not give you back what you want.

Please complete the form Abelincoln_distributed.pdf

< -
dbremer@donneray.com © Reply © Reply All Forward
To dbremer@donneray.com Mon 2021-06-21 12:15 PM
(&) We removed extra line breaks from this message.
Abelincoln_distributed. pdf _, Open PDFs in Adobe Acrobat X
ok | 276 KB

You are invited to complete the form "AbeLincoln_distributed.pdf". You can use Adobe Acrobat or Adobe Acrobat Reader to fill in this form.
Click the attachment to open the form in Adobe Acrobat or Adobe Acrobat Reader. When you are finished, click Submit to return your data to the form author.

Get the free latest version of Adobe Acrobat Reader from:

<http://www.adobe.com/go/reader>

When opening the document up in Acrobat:

Home Tools Abelincoln_distrib... x

B v ® 8 - \UMORIC)

Comment B T T T T g & & G &
Please fill out the following form. When finished, click Submit Form to return

@ the completed form. Highlight Existing Fields

Submit Form

YOUR LA0 Reaet Company Name
@ Applying for Positio Preferred Programming Language: PHP ;I

Can drive to work: m Languages Known:
Can bring donuts to k: O O O c
Start Date: S:H'
ava
Employment Appiication PHP

Applicant Information

R

Fill out some of the form and then select the submit form button.
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Send Form X

To: X@X.com
Subject: Submitting Completed Form
Attachment: Abelincoln_distributed.pdf

From:

Email Address:

Idbremer@donneray.com

Full Name:

|Don Bremer

Remember me:

.‘.—) To save your email address and name in Adobe Acrobat's Identity
¥ preferences, check Remember me. Do not check this box if you are using

a public computer.

When we get the form, we can then brin it into the existing response file:

d Form to Response File X

Comple

This file is a completed form and will be added to a response file.

(®) Add to an Existing Response File

|J\June1 8202 1\FilledForms\Abelincoln_responses.pdf ~ Browse...

O Create a New Response File

| Browse...

Help OK Cancel

File Edit View Fill Window Help

Home  Tools AbeLincoln_distrib... AbeLincoln_respon... %

Bwx ® 8

Received Date FullName Date Address City Phone Email Date Available Social Security No Desired Salary Position Applied for YES NO YES2 NO2 VES3 NO3 Ifyeswhen YES4 NOA Ifyesexplain |
2021-06-21 12:24:.. Abe off
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@ Tracker

[y Latest Updates

Forms > Distributed > Abelincoln_responses A

C:\Users\Don\Desktop\June182021\FilledForms\AbeLincoln_responses.pdf (Edit file location

2021-06-21 12:14:51 PM using email attachment

v i Reviews Tl View Responses
[ sent
Response File Location:
% Joined
D’: Distributed On:
~ & Forms

~ 5'4> Distributed ij Open Original Form

" AbeLincoIn_response§

4 . =
=L, Received &J SRS
Recipients Responded (New): 1
Recipients Not Responded: 1
Total Recipients: 2
pe-] ; - =] ;
,j Email All Recipients ,_-P Add Recipients
Email Recipient Name
dbremer@donneray.com
donbremer@gmail.com
Expand All Collapse Al (@ T <

1
't._—) Email Recipients Who Haven't Responded

Don Bremer

Responded Last Response Date/Time
Yes (1) 2021-06-21 12:24:38 PM
No

To open up tracking — go to Edit>Form Options.

If the file was asked to get signatures, then it would ask you to se it up in Adobe Sign!

Adobe Sign

| showed you signatures in the previous class, but in
this section, we can send people the files to sign and
track them.

Open AdobeSign.pdf

Then select, Request Signatures.

Add the people to send it to in the add signers.
Then, we specify where to sign...

Remember to flip to sign in any order under more
options.

Get documents sighed
Send an agreement to others for e-signing, approval, or other processing

Recipients *
@ complete in Any Order

é’ Enter recipient email

Show CC

}“ Adobe Sign
Get documents signed fast with Adobe Sign

Add signers, specify where to sign, send and track progress. Learn more

Add signers Add C(

2£2 ~ dbremer@donneray.com

2£7 ~ donbremer@gmail.com

AdobeSign

Please review and sign this document.

File(s)

More Options Cancel Specify Where to Sign
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Since we have two people signing, bring in two signature fields and two initial fields.

Right-click on the fields to assign each to a different signer.

@ Advanced editing on
RECIPIENTS
[l dbremer@donneraycom v
(signer)
< nitials
Initials2 & Signature Fields ~
Assigned To dbremer@donneray.com (Signe Signature
dbremer@donneray.com (Signer)
Field Type donbremer@gmail.com (Signer) Initials
Required Signature Block
Tools v Stamp
Delete Field Signer Info Fields b
Data Fields b
* x
Signature
Transaction Fields v

* | .
All Your Base Belong to Us! Initials

Signed:
asdfadsf
* N
Signature
* N
Signature

Then select send!

Reset Fields

O save astemplate

Page 15 of 20



Optimize

The size of the file can be selected during any point in the
creation process — first print, web print, iteration, etc. So,
let’s start at the beginning — at Word.

Using the High Quality Print (like sending it to a
professional printer) — the file is actually larger than the
Word document!

#29 Adobe PDF Document Properties

Layout Paper/Quality [ad Adobe PDF Settings
Adobe PDF Conversion Settings

Use these settings to create Adobe PDF documents for quality printing on desktop printers
and proofers. Created PDF documents can be opened with Acrobat and Adobe Reader 5.0

and later.
Default Settings: | High Quality Print v Edit.
‘Adobe PDF Security: None 4 Edit.
Adobe PDF Output Folder: Prompt for Adobe PDF filename v Browse.__
Adobe PDF Page Size: Letter 4 Add.

Replace Existing PDF: Always
View Adobe PDF results
Add document information
Rely on system fonts only; do not use document fonts

Delete log files for successful jobs

‘ﬁ Windows 8.docx 2013-05-14 4:24 PM Microsoft Word Doc...

Windows8.pdf 2021-06-21 12:48 PM Adobe Acrobat Docu...

Windows 8-large.pdf 2021-06-21 12:51 PM Adobe Acrobat Docu... 7,011 KB Cancel

So, if we get this behemoth file, what can we do to make it smaller and how will that

affect our final product?

‘a Reduce File Size | ~ . ﬁ Advanced Optimization  2£%) Optimize Scanned Pages E‘ Prefli
e g = P ='0p g Q

The easiest thing we can do is to Reduce File size.

Doing this, I've reduced the file size from 7M to 2M! The 2M file is my default file

size — | usually don’t print out stuff for High Quality Print.

But, let’s talk about some of the Advanced Optimizations:

Optimize PDF

| Add |~ |
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PDF Optimizer

Settings:  Standard

Images

Fonts

O Transparency
Discard Objects
Discard User Data
Clean Up

Current PDF Version: 1.6 {Acrobat 7.x)

B4 Delete Save

Make compatible with; | Retain existing

Image Settings

Color Images :

Downsample: | Bicubic Downsampling to v | (150 ppi for images above 225 ppi.
Off
Compression: |Average Downsampling to Medium ~
Subsampling to
Bicubic Downsampling to
Grayscale Images :
Downsample:  Bicubic Downsampling to > 150 ppi for images above  [223 Ppi.
Compression:  JPEG ¥ Quality: |Medium ~
Monochrome Images :
Downsample;  Bicubic Downsampling to v oo ppi for images above (420 Ppi.
Compression:  JBIG2 ¥ Quality: |Lossy >

Optimize images only if there is a reduction in size

Audit space usage...

All units are in pixels per inch (ppi).

If the downsample is off, it will give you the best picture at the largest AuditSpace Usage
size. Results
Description Bytes Percentage
| usually use bicubic downsample — this uses the most math to get the
. Images 1,986,500 91.14 %
beSt pICture' Content Streams 20,571 0.94 %
3 . . Fonts 161,329 740 %
Average and Subsampling will get files that may not look so good R e e
(depending on file type) — but they will be easy on the computer and Exended Graphics Sates 43 000%
Total 2,179,650 100 %

get small file sizes.
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Accessibility

The Accessibility Check option will run a quick check will run a quick
check on the document and find problems.

Report Options
Create accessibility report
Folder: H:\My Documents Choose...

[] Attach report to document

Page Range

(®) All pages in document (O Pages from 1 to |1

Checking Options (31 of 32 in all categories)

Category: | Document b

Accessibility permission flag is set

Document is not image-only PDF

Document is tagged PDF

Document structure provides a logical reading order
Text language is specified

Document title is showing in title bar

Bookmarks are present in large documents

Document has appropriate color contrast

Select All Clear All

Show this dialog when the Checker starts

Help Start Checking Cancel

Accessibility

Accessibility Checker

=]~

Document (4 issues)
Page Content

Forms

Alternate Text (1 issue)
Tables (1 issue)

Lists

Headings

Autotag Document

Reading Options
Accessibility Check

Accessibility Report

Identify Form Fields

Set Alternate Text
Setup Assistant

Reading Order
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Using a PDF is great — and we want to make sure that is the case even if you are using a screen reader.
Open the document — Basics-of-Spreadsheets2010.pdf
User the Accessibility Check to find out what is wrong with the document.

Logical Reading Order and Color contrast will always pop up and require a manual check. But, really, it’s
about the Alternate Text!

We may want to autotag the document- this will show what we are missing or what we need to fix. In
this document — it is quite extensive.

Accessibility

First AutoTag - then set Alternate Text! [@  Recognition Report

Add Tags Report for Basics-

As you go through and tag the images, the next time you run the checker —
of-Spreadsheets2010.pdf

there will be fewer items to fix!

) . . ) ) Summary
With the reading options, we can pick how the document is to be read.
Introduction

2 reduced confidence pages
118 figures missing AltText
Hints for Repair

Change Reading Options of Current Document x

Reduced Confidence Pages

Change reading options of this document from Infer reading order from Page 5: Previous Page | Next Page

document:

* Regions to check. (How To Fix Region
Tagging

Reading Order Options

1. Medium-Low confidence

Reading Order- |Infer reading order from document .
g Page 15: Previous Page | Next Page

Infer reading order from document

Left-to-right, top-to-bottom reading order « Regions to check. (How To Fix Region

Tagging

1. Medium-High confidence

Use reading order in raw print stream
Reading Mode OptidTagged reading order

(O Read the currently visible pages cnly

Accessibility

(®) Read the entire document

The checker found 118 Figure(s) which might
not be accessible because they do not contain
either an AltText or ActualText string. (How

To Fix AltText Tagging)

« Figure missing AltText on page 1.
« Figure missing AltText on page 1.
« Figure missing AltText on page 3.

L - S

Click on each item and with the Accessibility tools open, click on Set Alternate text.

eport

=, Identify Form Fields

Presented and co-sponso, | """ |
CENTER 7or ECONOMIC DEVELOPMEN

UNIVERSITY OF MINNESOTA DULUTH
Dri to Di ,_
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After doing a few images, you can re-run the checker and see that the alternate text figures have
changed to exclude the ones we have done.

Color Contrast
This is a manual check. You can check this out using the website:

https://contrastchecker.com
Open the document ContrastChecker.pdf

So, if you place some of the items in the checker — you can see that some combinations do not pass.

Others?

Compare Documents
Action Wizard
Index

Javascript
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